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Legal Notices
© 1995-2011, Dassault Systèmes SolidWorks Corporation, a Dassault Systèmes S.A. company,
175 Wyman Street, Waltham, Mass. 02451 USA. All Rights Reserved.

The information and the software discussed in this document are subject to change without
notice and are not commitments by Dassault Systèmes SolidWorks Corporation (DS SolidWorks).

No material may be reproduced or transmitted in any form or by any means, electronically or
manually, for any purpose without the express written permission of DS SolidWorks.

The software discussed in this document is furnished under a license and may be used or
copied only in accordance with the terms of the license. All warranties given by DS SolidWorks
as to the software and documentation are set forth in the license agreement, and nothing
stated in, or implied by, this document or its contents shall be considered or deemed a
modification or amendment of any terms, including warranties, in the license agreement.

Patent Notices

SolidWorks
®
3D mechanical CAD software is protected by U.S. Patents 5,815,154; 6,219,049;

6,219,055; 6,611,725; 6,844,877; 6,898,560; 6,906,712; 7,079,990; 7,477,262; 7,558,705;
7,571,079; 7,590,497; 7,643,027; 7,672,822; 7,688,318; 7,694,238; 7,853,940 and foreign
patents, (e.g., EP 1,116,190 and JP 3,517,643).

eDrawings
®
software is protected by U.S. Patent 7,184,044; U.S. Patent 7,502,027; and

Canadian Patent 2,318,706.

U.S. and foreign patents pending.

Trademarks and Product Names for SolidWorks Products and Services

SolidWorks, 3D PartStream.NET, 3D ContentCentral, eDrawings, and the eDrawings logo are
registered trademarks and FeatureManager is a jointly owned registered trademark of DS
SolidWorks.

CircuitWorks, FloXpress, TolAnalyst, and XchangeWorks are trademarks of DS SolidWorks.

FeatureWorks is a registered trademark of Geometric Ltd.

SolidWorks 2012, SolidWorks Enterprise PDM, SolidWorks Workgroup PDM, SolidWorks
Simulation, SolidWorks Flow Simulation, eDrawings Professional, and SolidWorks Sustainability
are product names of DS SolidWorks.

Other brand or product names are trademarks or registered trademarks of their respective
holders.

COMMERCIAL COMPUTER SOFTWARE - PROPRIETARY

The Software is a “commercial item” as that term is defined at 48 C.F.R. 2.101 (OCT 1995),
consisting of “commercial computer software” and “commercial software documentation” as
such terms are used in 48 C.F.R. 12.212 (SEPT 1995) and is provided to the U.S. Government
(a) for acquisition by or on behalf of civilian agencies, consistent with the policy set forth in
48 C.F.R. 12.212; or (b) for acquisition by or on behalf of units of the department of Defense,
consistent with the policies set forth in 48 C.F.R. 227.7202-1 (JUN 1995) and 227.7202-4 (JUN
1995).
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In the event that you receive a request from any agency of the U.S. government to provide
Software with rights beyond those set forth above, you will notify DS SolidWorks of the scope
of the request and DS SolidWorks will have five (5) business days to, in its sole discretion,
accept or reject such request. Contractor/Manufacturer: Dassault Systèmes SolidWorks
Corporation, 175 Wyman Street, Waltham, Massachusetts 02451 US.

Copyright Notices for SolidWorks Standard, Premium, Professional, and
Education Products

Portions of this software © 1986-2011 Siemens Product Lifecycle Management Software Inc.
All rights reserved.

This work contains the following software owned by Siemens Industry Software Limited:

D-Cubed
™
2D DCM © 2011. Siemens Industry Software Limited. All Rights Reserved.

D-Cubed
™
3D DCM © 2011. Siemens Industry Software Limited. All Rights Reserved.

D-Cubed
™
PGM © 2011. Siemens Industry Software Limited. All Rights Reserved.

D-Cubed
™
CDM © 2011. Siemens Industry Software Limited. All Rights Reserved.

D-Cubed
™
AEM © 2011. Siemens Industry Software Limited. All Rights Reserved.

Portions of this software © 1998-2011 Geometric Ltd.

Portions of this software © 1996-2011 Microsoft Corporation. All rights reserved.

Portions of this software incorporate PhysX
™
by NVIDIA 2006-2010.

Portions of this software © 2001-2011 Luxology, LLC. All rights reserved, patents pending.

Portions of this software © 2007-2011 DriveWorks Ltd.

Copyright 1984-2010 Adobe Systems Inc. and its licensors. All rights reserved. Protected by
U.S. Patents 5,929,866; 5,943,063; 6,289,364; 6,563,502; 6,639,593; 6,754,382; Patents
Pending.

Adobe, the Adobe logo, Acrobat, the Adobe PDF logo, Distiller and Reader are registered
trademarks or trademarks of Adobe Systems Inc. in the U.S. and other countries.

For more SolidWorks
®
copyright information, see Help > About SolidWorks.

Copyright Notices for SolidWorks Simulation Products

Portions of this software © 2008 Solversoft Corporation.

PCGLSS © 1992-2010 Computational Applications and System Integration, Inc. All rights
reserved.

Copyright Notices for SolidWorks Enterprise PDM Product

Outside In
®
Viewer Technology, © 1992-2011 Oracle

© 2011, Microsoft Corporation. All rights reserved.

Copyright Notices for eDrawings Products

Portions of this software © 2000-2011 Tech Soft 3D.

Portions of this software © 1995-1998 Jean-Loup Gailly and Mark Adler.

Portions of this software © 1998-2001 3Dconnexion.
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Portions of this software © 1998-2011 Open Design Alliance. All rights reserved.

Portions of this software © 1995-2010 Spatial Corporation.

This software is based in part on the work of the Independent JPEG Group.
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Introduction
This guide describes new and changed SolidWorks

®
Enterprise PDM capabilities in the 2012

release.

Intended Audience

This guide is for experienced users of the SolidWorks Enterprise PDM software.
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1
SolidWorks Enterprise PDM

Available as a separately purchased product that can be used in SolidWorks Standard,
SolidWorks Professional, or SolidWorks Premium.

This chapter includes the following topics:

• Administration Tool
• File Explorer and SolidWorks Add-in
• Product Support
• System Performance
• Web Client Access Extended

Administration Tool

Customized Enterprise PDM Menus
You can customize how menus and submenus are displayed in the Windows Explorer user
interface.

You can change the available commands and command order for these menus on the
Enterprise PDM Menu bar:

• Actions
• Modify
• Display
• Tools

You can customize shortcut menus that display in the File View pane when:

• Files are selected
• Folders are selected
• Nothing is selected

Customizing Menus
Use the Menus page of the Settings dialog box to customize menus displayed to users in
the Windows Explorer File View.

To customize a user's menus:

1. In the Administration tool, expand Users and double-click the user whose menus
you want to customize.

2. In the Properties dialog box, click Settings.
3. In the left pane of the user's Settings dialog box, click Menus.
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4. In the Destination Menu drop-down list, select the File View menu to modify:

The shortcut menu displayed when the user right-clicks
with nothing selected.

Background Right
click

The shortcut menu displayed when the user right-clicks
with a file selected.

File Right click

The shortcut menu displayed when the user right-clicks
with a folder selected.

Folder Right click

The Actions menu on the Enterprise PDM menu bar.Bar\Actions

The Modify menu on the Enterprise PDM menu bar.Bar\Modify

The Display menu on the Enterprise PDM menu bar.Bar\Display

The Tools menu on the Enterprise PDM menu bar.Bar\Tools

The commands for the selected menu are listed.

5. Do any of the following:

• To remove a command, select it and click .
• To add a separator to the menu, select the command you want below the separator

and click .
• To add a command to the menu, under Available commands, use the Flat list

or Categorized tabs to display the available commands.

Drag the command to the location you want or click to add the selected
command to the bottom of the menu.

• To change the location of a command or divider in the menu, select it and click

or .

6. To modify another menu, repeat steps 4 and 5.

You can add the same command to multiple menus.

7. Do one of the following:

• Click Apply to save your changes and close the Settings dialog box.
• Click Cancel to close the Settings dialog box without saving your changes.

When prompted to confirm that you do not want to save changes, click Yes.

Copying Menu Settings
You can create customized menus for one user and copy them to other users.

To copy customized menus from another user:

1. On the Menus page of the Settings dialog box, click Copy.
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2. In the Copy Menu Settings dialog box, underMenus to copy, do one of the following:

• Select <Copy All Menus>.
• Select a specific menu to copy.

3. Under Source user, select the user whose settings you want to copy.
4. Click OK.
5. Click Apply.

Returning to Default Menu Settings
You can return a user's menus to their default settings. Resetting returns all menus to
their default settings.

1. On the Menus page of the Settings dialog box, click Reset.
2. When prompted to confirm that you want to reset all menus, click OK.

Displaying Full User Names in the User Interface
If login names are cryptic, you can display users' full names in the user interface to make
it easier to identify who is using a file.

In Enterprise PDM, user names are displayed to indicate who has checked out or created
files, sent or received mail messages, or initiated actions performed on files.

If your company creates users with truncated user names, for example, by importing
users from Windows Active Directory, it may be difficult to identify individuals just by
their login names.

You can modify your user settings in the Administration tool to specify that the full names
of users are displayed throughout the user interface.

Compare these examples of the Checked Out By column in File View in Windows Explorer:

Full names displayed:Login names displayed:

To display full user names:

1. In the left pane of the Administration tool, expand Users.
2. Right-click your user name and click Settings.
3. In the left pane of the Settings dialog box, click Explorer.
4. Under Miscellaneous, select Show full user names.
5. Click Apply.
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Replication Failover
Replication has been made more fault-tolerant to handle WAN scenarios where not all
servers are available at all times.

If the first attempt to retrieve a file fails, the Archive server uses a lookup table to select
other servers from which to replicate the file. This table prioritizes servers based on
replication settings you provide using the Administration tool. If each attempt to get the
file fails, the Archive server retries the operation.

By default, the replication server retries twice before it times out. You can change the
number of retries by creating a new DWORD key on the archive server called RetriesCount
at the following registry location:
HK_LOCAL_MACHINE\SOFTWARE\SolidWorks\Applications\
PDMWorks Enterprise\ArchiveServer\Vaults\vault_name

The hexadecimal value you set for the RetriesCount keyword controls the number of
retries.

File Explorer and SolidWorks Add-in

Browse to Option
The Browse to option on the shortcut menu of the Contains and Where Used tabs changes
the focus of the tab to the referenced file to which you browse.

In previous versions, the Browse To option opened a new Windows Explorer window.
In SolidWorks Enterprise PDM 2012, the Browse to option changes the focus to the
referenced file without opening a new window.

The new behavior also applies when you navigate to vault files using the File Explorer
Contains and Where Used tabs in the Open and Save As dialog boxes. This behavior
occurs whether you access the dialog boxes from the SolidWorks software or from any
standard Microsoft Windows application such as Notes and Microsoft Office.

You can also open a new window using the new Browse to in a New Window option.

Using Browse to
Use Browse to when you want to change focus to a referenced file without opening a
new dialog box.

This example describes how to change the focus of the Contains tab to a referenced file
without opening a new dialog box.

1. In the File View pane, select a vault file and click the Contains tab to list the files it
references.

2. Right-click a referenced file and click Browse to.

The focus of the Contains tab changes to the file you selected.
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Using Browse to in a New Window
Use Browse to in a New Window when you want to open a new window with the focus
on a selected file.

1. In the File View pane, select a vault file and click the Where Used tab to list the files
that reference it.

2. Right-click a file, and click Browse to in a New Window.
A new window opens to the same folder and tab, but with the focus changed to the
file you selected.

The original window remains open.

Exporting Indented Bills of Materials
You can preserve the indented structure of an Enterprise PDM computed bill of materials
(BOM) or a saved BOM when you export it to a Microsoft Excel spreadsheet. When
prompted, choose to add a Level column to the output file. The added column contains
a numerical representation of the BOM’s levels.

To preserve the indented structure of a BOM:

1. In Windows Explorer, select a vault assembly.

2. On the Bill of Materials tab, click BOM Display - Indented .

3. Click Open As CSV .
4. When prompted to create a Level column in the CSV file, click Yes.

A Level column, with numerical values representing the BOM structure, appears as
the first column in the spreadsheet. You can use the column to sort the exported BOM.

Searching Within File-based Dialog Boxes
The embedded Enterprise PDM search lets you search for files and folders within Windows
Explorer and all standard file-based dialog boxes.

You can use this method to search from:

• SolidWorks file-based dialog boxes, such as Open, Save As, Insert, and Replace.
• The Open and Save As dialog boxes of applications such as Microsoft Word and Excel,

and Adobe Reader.

To perform an embedded search:

1. Do one of the following:

• Click Open Search (Enterprise PDM menu bar).

By default, the Complete Search card is used.

• If you have access to multiple file search cards, expand Open Search and select a
search card to use.

The search card appears in the top right pane.
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2. Do one of the following:

• Use the criteria on the card to define the search and click Start Search .

• If you have saved searches as favorites, expand Favorite Searches and
select the search to use.

3. To restore all fields on the search card to their default values, click Clear Search .

4. To close the embedded search, click Close Search .

The embedded search can only be used to search for files or folders. To search for items
or users, use the Enterprise PDM Search tool.

To open the Enterprise PDM Search dialog box:

1. Expand Open Search and click Search Tool.
2. Select the search card to use from the Searches list in the left pane.

Version Toggle on Where Used Tab
On the Where Used tab, you can use the Version button to toggle between viewing
references for all versions of a file and selecting the file version for which references are
displayed.

Additionally, a redesigned Configurations button on the Where Used and Contains tabs
hides all configurations or lets you select the configuration to use.

Both the Version and Configurations toggle states persist:

• When you select a different file in File View
• When you change folders
• Between Enterprise PDM vault sessions

Displaying Versions
The Version button is active on the Where Used tab.
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On the Contains tab, Version serves as a label for the version dropdown list. You can
select specific versions, but you cannot select <All Versions>.

With a vault file selected in File View, on the Where Used tab, do one of the following:

• To display files that reference all versions of the selected file, to the left of the top

drop-down list, click .

The Version: button is highlighted, and the drop-down list displays <All Versions>.

When all versions are displayed, you cannot select a specific configuration to
display.

• To display files that reference a specific version of the selected file, click .

The Version button is no longer highlighted, and you can choose a specific version
from the drop-down list.

The highlighted Configuration button indicates that you can select a configuration
from the drop-down list.

Displaying Configurations
On both the Where Used and Contains tabs, the Configuration button lets you enable
or disable the choice of configurations.

With a vault file selected in File View, use these methods to display configurations:

1. On the Contains tab:

• When the Configuration button is active, use the dropdown list to select the
configuration for which to display referenced files.

• To deactivate the Configurations drop-down list, click Configuration.

The button becomes a label and the drop-down list indicates that you have chosen
not to show configurations.

2. On the Where Used tab:
a) If Version is active, click to deactivate it, and click Configuration to activate the

ability to choose configurations.
The Configuration button is highlighted and the drop-down list becomes active.

b) Use the drop-down list to select the configuration to display.
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Dialog Box Toolbars
A toolbar has been added to the dialog boxes you use to manipulate groups of files. This
makes it easier to access commands that were previously only available through a shortcut
menu.

The toolbars contain new buttons and in some cases, modified buttons.

DescriptionCommandButton

Lets you use wildcards to select a group of files.Select Files

Opens a list of files in Microsoft Excel.Open File List

Lets you save the file list as a comma-separated .txt
file.

Save File List

New flyout control:

Lets you link an item to a specific file configuration.Generate for
configurations

Lets you link an item to a file independent of
configurations.

Generate for files only

New flyout control:

Uses the attached version of the references.Referenced version

Uses the latest version of the references.Latest version

The following dialog boxes contain the toolbars:

AccessDialog Box

XXXAction > Get Latest Version

Action > Get Version

Get

XXXAction > Check InCheck In

XXXAction > Check OutCheck Out\
Undo Check Out

XXXModify > Change StateDo Transition

XXXXModify > Increment RevisionIncrement
Revision

XXXXXFrom Item Explorer dialog box:

Right-click an item and select Link
Files to Item. Select one or more
files and click Open.

Link Files to
Item
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Product Support
SolidWorks Enterprise PDM 2012 offers expanded support for CAD systems, Microsoft

®

Office, Internet Explorer
®
, and 64-bit processors.

The following support is available:

64-bit PlatformsMicrosoft ProductsCAD Tools

Enterprise PDM Web ServerMicrosoft Office 2010SolidWorks 2012

AutoCADInternet Explorer 9AutoCAD
®
2012

Solid EdgeAutodesk Inventor
®
2012

Solid Edge
®
ST3

System Performance
System performance has been improved for users working with large data sets and users
working remotely with Copy Tree and template-created documents.

• Improved system response time with large data sets

Users will now see significantly quicker system response when working with large data
sets.

In previous versions of Enterprise PDM, long delays or system stoppages could occur
when users worked with large data sets with many parent child relationships. Affected
functions included viewing the information on the Contains tab in Windows Explorer or
in a CAD add-in when the Archive refresh rate is set at a low value, for example, five
seconds.

• Creating new documents from remote replicated sites with high latency connections
to the SQL Server

It now takes less time for users in remote offices to create new documents using
templates and the Copy Tree tool.

Combining the queries that save card variables has made the creation of documents
from templates as much as three times faster.

Improved query methods have optimized WAN traffic for the Copy Tree operation,
making the new response time up to 10 times faster.

Web Client Access Extended
The SolidWorks Enterprise PDM Editor license now includes access to the Enterprise PDM
Web Client. This provides greater flexibility for users that are away from the office but
still need to access the system, and for external users, such as vendors or customers,
that need occasional access.

In addition to providing access to CAD applications, you can use Editor licenses to access
the Web client to search the vault and perform basic functions to enable remote work
processes.

Licenses in the license pool are used in this order:

• Contributor licenses
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• Editor licenses
• Processor license
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